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Q.1 पाँच MS-Word डॉ� युम�ट एक �व�श� ट समय पर खलेु हुए ह�। य�द आप इन खलेु हुए डॉ� युम��स पर बार�-बार�
से जाना चाहत ेह�, तो आप �कस टैब का उपयोग कर�गे?

Ans 1. File > Switch windows

2. Home > Switch windows

3. Tools > Switch windows

4. View > Switch windows

Question Type : MCQ
Question ID : 6182781097

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.2 MS-Word डॉ� युम�ट म� 'टेबल ऑफ क�ट�ट' को जोड़ने के �लए, आप ______ मे� यू का चयन कर�गे।
Ans 1. लेआउट

2. इं� सट�

3. रेफ़र�सेस

4. �र� यू

Question Type : MCQ
Question ID : 6182781096

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.3 241.1.2.234 � लास ______ का आइपी (IP) अ�से है।
Ans 1. B

2. A

3. D

4. E

Participant ID
Participant Name
Test Center Name iON Digital Zone iDZ 2 Patliputra
Test Date 19/12/2019
Test Time 9:00 AM - 10:00 AM
Subject Data Entry Operator
Marks Obtained 13.00000
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Question Type : MCQ
Question ID : 6182781138

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.4 MS-Word डॉ� यमु�ट म� ‘Insert’ → ‘Object’ �वक� प का इ� तमेाल करत ेहुए एक मौज़दूा वक� शीट से डटेा
को अतं:� था�पत करने (embedding) के संदभ� म� �न�न�ल�खत म� से कौन सा कथन स� य है?

Ans 1. केवल एक �र� त MS-Excel फ़ाइल इ� सट� क� जा सकती है।

2. MS-Word डॉ� यमु�ट म� क� गई ए�बेडडे MS-Excel ऑ�ज़े� ट को ए�डट नह�ं �कया जा सकता है।

3. मौज़दूा MS-Excel फ़ाइल इस तरह ए�बेडडे क� जा सकती है, वड� डॉ� यमु�ट म� केवल एक MS-

Excel का आइकॉन �दखेगा।

4. केवल डटेा वाल� एक MS-Excel फ़ाइल इ� सट� क� जा सकती है।

Question Type : MCQ
Question ID : 6182781098

Status : Marked For Review
Chosen Option : 3

Marks : 1.00

Q.5 MS-Excel म� वक� शीट क� ने�मगं के �लए �न�न�ल�खत म� से कौन सा वधै फ़ाइल नाम है?

Ans 1. Budget/1

2. Budget[1]

3. Budget-1

4. Budget.1

Question Type : MCQ
Question ID : 6182781111

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.6 MS-PowerPoint म� � लाइड सॉट�र � य ूके संदभ� म� �न�न�ल�खत म� से गलत कथन का चयन क�िजए।
Ans 1. �कसी � लाइड के क�टे�ट को प�रव�त�त करता है

2. इसे सेले� ट करने के �लए एक � लाइड पर  ि�लक करता है

3. एक � लाइड को �डल�ट करता है

4. � लाइ�स को थंबनेल �प�चस� के �प म� करता है

Question Type : MCQ
Question ID : 6182781133

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.7 बज़ट और �व� तीय ��तवेदन� के जसेै अकं�य डटेा को संग�ठत, �व� ले�षत व आले�खत करने वाले �ो�ाम
______ कहलात ेह�।

Ans 1. � �ेडशी�स

2. �ा�फ़� स
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3. वड� �ॉसेसस�

4. DBMS

Question Type : MCQ
Question ID : 6182781087

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.8 MS-Excel म�, ‘View’ मे� य ुके अतंग�त �न�न�ल�खत म� से कौन सा फ़�चर उपल� ध नह�ं होता है?

Ans 1. Split Columns

2. New Window

3. Freeze Panes

4. Arrange All

Question Type : MCQ
Question ID : 6182781113

Status : Marked For Review
Chosen Option : 3

Marks : 0.00

Q.9 मेल मज़� के �लए डटेा सोस� के �प म� MS-Excel � �ेडशीट तयैार करने के �लए, यह स�ुनि�चत कर� �क आपक�
� �ेडशीट म� ______ के नाम, उन फ�� ड के नाम� से समेु�लत ह� िज� ह� आप अपनी मेल मज़� म� इ� सट� करना
चाहत ेह�।

Ans 1. कॉलम

2. सेल

3. वक� शीट

4. रो

Question Type : MCQ
Question ID : 6182781107

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.10 �न�न�ल�खत म� से कौन सी टे� नोलॉज़ी का उपयोग ब�क� �वारा चेक क� ���या के �लए �कया जाता है?

Ans 1. OMR

2. MICR

3. QR

4. OCR

Question Type : MCQ
Question ID : 6182781083

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.11 � लास A नेटवक�  म�, पहले ______ �बट, अ�से के नेटवक�  पाट� होत ेह� और ______ शषे �बट अ�से के हो� ट
पाट� होत ेह�।

Ans

ww
w.
ex
am
mi
x.c
om

Visit -  www.exammix.com & Free Download, All Previous Question Papers (Hindi & English)

Free Downloaded From  -  www.exammix.com



1/27/2020 https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S67D303/157682171263038…

https://cdn3.digialm.com//per/g21/pub/1631/touchstone/AssessmentQPHTMLMode1//1631O193/1631O193S67D303/15768217126303830/1937553… 4/17

1. 16; 16

2. 24; 8

3. 4; 28

4. 8; 24

Question Type : MCQ
Question ID : 6182781139

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.12 MS-Excel म�, ‘Lock’ या ‘Unlock Cells’ फ़ं�शन के काय� करने के �लए, इनम� से �कस �वक� प को इनेबल
�कया जाना चा�हए?

Ans 1. ‘Protect Workbook’ फ़ं�शन को इनेबल करने क� आव� यकता है

2. ‘Smart Loop up’ फ़ं�शन को इनेबल करने क� आव� यकता है

3. वक� शीट को से� स के लॉक या अ� लॉक होने से पहले र��त �कया जाना चा�हए

4. ‘Lock’ या ‘Unlock Cells’ �वक� प� के अलावा �कसी अ� य फ़ं�शन को इनेबल करने क�
आव� यकता नह�ं है

Question Type : MCQ
Question ID : 6182781117

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.13 MS-Excel म� ______ आपको फ़ॉम�ट कोड़ वाल� फ़ॉम��टगं लागू करने पर �दखने वाल� सं� याओ ंके तर�के म�
प�रवत�न करने क� स�ुवधा देता है। यह उस ि�थ�त म� उपयोगी होता है जब आप सं� याओ ंको अ�धक पठनीय
फ़ॉम�ट म� दशा�ना चाहत ेह�, या आप सं� याओ ंको टे� � ट या �सबं� स के साथ संयोिजत करना चाहत ेह�।

Ans 1. टे� � ट फ़ं� शंस

2. लॉिज़कल फ़ं� शंस

3. मथै फ़ं� शंस

4. लकुअप फ़ं� शंस

Question Type : MCQ
Question ID : 6182781127

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.14 MS-Excel म� �ोटे� शन फ़�चस� के संदभ� म� �न�न�ल�खत म� से कौन सा अस� य है?

Ans 1. वक� शीट लेवल �ोटे� शन �स� यो�रट� फ़�चर के �प म� अ�भ�ेत नह�ं होता है। यह केवल �यो� ताओं
को वक� शीट म� लॉक क� हुई से� स म� प�रवत�न करने से रोकता है।

2. आप शीट �ोटे� शन के साथ यह �न�द�� ट कर सकत ेह� �क यज़ूर शीट म� वा� तव म� � या कर सकता
है, िजससे यह स�ुनि�चत होता है �क आपक� वक� शीट म� कोई भी मह� वपणू� डटेा �भा�वत नह�ं होता है।

3. आप पासवड� �न�द�� ट करके अपनी वक� बकु के � ��चर को लॉक नह� ंकर सकत ेह�।

4. MS-Excel म�, आप MS-Excel फ़ाइल को पासवड� �न�द�� ट करके लॉक कर सकत ेह� िजससे यज़ूर
इसे खोल या प�रव�त�त नह�ं कर सकत ेह�।

Question Type : MCQ
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Question ID : 6182781124
Status : Answered

Chosen Option : 1
Marks : 0.00

Q.15 MS-Word म� मेल मज़� के �लए, य�द आप MS-Excel म� डटेा सोस� का इ� तमेाल कर रहे ह�, तो इसम� कुछ
� पे�स�फ़केशन �मल सकत ेह�। इस संदभ� म�, �न�न�ल�खत म� से कौन सा कथन गलत है?

Ans 1. फ़�� ड के नाम/कॉलम के लेबल �ल� ट क� पहल� पंि�त म� होने चा�हए, और फ़�� ड के नाम �व�श� ट
(unique) होने चा�हए

2. �ल� ट म� कोई �र� त � तंभ या पंि�त नह�ं होने चा�हए

3. फ़�� ड के नाम� तथा �थम �रकॉड� के म� य म� �र� त पंि�त होनी चा�हए

4. य�द वक� शीट म� कोई अ�त�र� त सचूना है, तो कम से कम एक �र� त पंि�त या � तंभ होना चा�हए
जो �ल� ट को अ� य डटेा से पथृक कर सके

Question Type : MCQ
Question ID : 6182781106

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.16 ______ सोस� कोड़ को इंटरमी�डएट फॉम� म� �पांत�रत करता है और �फर उस इंटरमी�डएट कोड़ को मशीन
ल�� वेज़ म� �पांत�रत करता है।

Ans 1. असे� बलर

2. �ॉसेसर

3. क� पाइलर

4. इंटर�ेटर

Question Type : MCQ
Question ID : 6182781089

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.17 ______ एक आइकॅन होता है जो आपको उस आइटम (डॉ� यमु�ट, ॲि�लकेशन या �प�चर) तक �नद��शत
करता है जो क� � यटूर म� कह�ं और ि�थत होता है। यह यज़ूर के �लए उस आइटम तक ॲ� सेस अ�धक सगुम
(आमतौर पर ड�ेकटॉप पर) बनाता है और इसे आइकॅन के कोने म� एक तीर छोटे तीर �वारा पहचाना जाता है।

Ans 1. � टाट� बटन

2. GUI

3. �ो�ाम

4. शॉट�कट

Question Type : MCQ
Question ID : 6182781091

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.18 वड� �ॉसे�सगं डॉ� यमु�ट म� टै� स व � पेसेज़ के मा� यम से क� जाने वाल� टे� � ट क� एलाइ�नगं एक क�ठन काय�
हो सकता है। MS-Word के �वारा �कसी ______ डॉ� यमु�ट म� टे� � ट के � तंभ� तथा पंि�तय� को आसानी से
एलाइन करने के �लए इ� सट� करना होगा।
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Ans 1. टेबल

2. टे� � ट बॉ� स

3. इ�ड��स

4. कॉल� स

Question Type : MCQ
Question ID : 6182781104

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.19 MS-Excel वक� शीट म� परेू � माट�आट� �ा�फ़क म� रंग� म� प�रवत�न करने के �लए:

� माट�आट� पर ि�लक कर�।
� माट�आट� टू� स के अतंग�त, ______ टैब पर, � माट� आट� �ुप म�,______ पर ि�लक कर�।

Ans 1. Design; SmartArt Styles; Change Colors

2. SmartArt Design; Format; Change Colors

3. Styles; Design; Change Colors

4. SmartArt Design; Styles; Change Colors

Question Type : MCQ
Question ID : 6182781130

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.20 MS-PowerPoint म�, आप � लाइड के साइज़ का �नधा�रण करने के �लए �वक� प कहाँ पा सकत ेह�?
Ans 1. � लाइड शो

2. �डज़ाइन

3. फ़ाइल

4. � यू

Question Type : MCQ
Question ID : 6182781134

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.21 �न�न�ल�खत का � या प�रणाम होगा?

Right-click on a filename > Send to > Desktop
Ans 1. ड�े कटॉप पर फ़ाइल खोल देगा

2. ड�े कटॉप पर फ़ाइल क� कॉपी बन जाएगी

3. ड�े कटॉप पर फ़ाइल का शॉट�कट आइकॉन बन जाएगा

4. फ़ाइल को ड�े कटॉप पर पहँुचा देगा

Question Type : MCQ
Question ID : 6182781093

Status : Answered
Chosen Option : 1
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Marks : 0.00

Q.22 �न�न�ल�खत म� से कौन सा ऐसा काय� है जो �मखु �प से सीपीय ू(CPU) का नह�ं है?

Ans 1. �ा�फ़कल �ॉसे�सगं करना

2. �ाइमर� � टोरेज़ या मेन मेमोर� के साथ �नकटता के साथ इंटरै� ट करना

3. ए�रथमे�टक व लॉिज़कल ऑपरेशन� को ��याि�वत करना

4. भंडा�रत (�टोड�) �ो�ाम �नद�श� को ��याि�वत करना

Question Type : MCQ
Question ID : 6182781082

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.23

Ans 1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182781136

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.24 मेल मज़� �ॉसेस म� तीन डॉ� युम�ट शा�मल होत ेह�: मेन डॉ� युम�ट, ______ तथा म�ड� डॉ� युम�ट।
Ans 1. डटेा सोस�

2. लेटर

3. फ़ॉम�

4. ईमेल

Question Type : MCQ
Question ID : 6182781105

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.25 ॲि�लकेशन सॉ�टवेयर के संदभ� म� �न�न�ल�खत म� से कौन सा कथन स� य है?

Ans 1. य ह �व�श� ट उ�े� य वाला सॉ�टवेयर है िजसका उपयोग �व�श� ट काय� करने के �लए �कया जाता है

2. इसे �लखने के �लए केवल लो-लेवल ल�� वेज़ का इ� तमेाल �कया जाता है

3. यह इ� पटु और आउटपटु �डवाइस� के म� य इंटरफ़ेस के �प म� धीरे-धीरे काय� करता है

4. इसके �बना क� � यूटर �स� टम संचा�लत नह�ं हो सकता है

Question Type : MCQ
Question ID : 6182781086

Status : Answered
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Chosen Option : 1
Marks : 1.00

Q.26 � लाइड शो के दौरान � ��न को काल� करने के �लए ______ दबाया जाता है।
Ans 1. Ctrl + B

2. B

3. F5

4. Alt + B

Question Type : MCQ
Question ID : 6182781135

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.27 य�द आप MS-Excel 2016 वक� शीट � ट�ड आउट पर �व�श� ट डटेा बनाना चाहत ेह�, तो ______, जैसे �क ॲरो,
� टार या बनैर (arrow, star or banner) का उपयोग करना एक अ� छा तर�का होगा।

Ans 1. आइकॉन

2. � माट�आट�

3. चाट�

4. शपे

Question Type : MCQ
Question ID : 6182781129

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.28

Ans

1. 

2. 

3. 

4. 

Question Type : MCQ
Question ID : 6182781118

Status : Answered
Chosen Option : 2

Marks : 0.00
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Q.29 आप अपने सम� त �ाहक� को एक मानक प� भेज रहे ह�। आप प� म� अपने �ाहक� के नाम व पत े�लखना
चाहत ेह�। MS-Word 2016 म� आप � या इ� सट� कर�गे?

Ans 1. मज़� फ�� �स

2. मेन डॉ� युम�ट

3. डटेा सोस�

4. मज़� डॉ� युम�ट

Question Type : MCQ
Question ID : 6182781109

Status : Marked For Review
Chosen Option : 2

Marks : 0.00

Q.30 MS-PowerPoint म�, ______ क� से�टगं के �लए ��गर �वक� प का उपयोग �कया जाता है।
Ans 1. इ� सट� अ चाट�

2. ॲ�नमेशन

3. � लाइड �डज़ाइन

4. �ांिज़शन

Question Type : MCQ
Question ID : 6182781132

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.31 MS-Word म�, एक परैा�ाफ़ के भीतर दो लाइन� के म� य क� दरू� ______ कहलाती है।
Ans 1. लाइन � पे�सगं

2. � पे�सगं

3. रो � पे�सगं

4. परैा�ाफ़ � पे�सगं

Question Type : MCQ
Question ID : 6182781101

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.32

Ans 1. 

2. 
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3. 

4. 

Question Type : MCQ
Question ID : 6182781126

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.33 8 पेज़ेस वाले MS-Word 2016 डॉ� यमु�ट म�, आप केवल पेज़ 2, 3, 6 और 8 का ��टंआउट लेना चाहत ेह�।
आप �कस से�टगं का इ� तमेाल कर�गे?

Ans 1. ��टं सेले� शन

2. क� टम ��टं

3. ��टं करंट पेज

4. ��टं ऑल पेजेस

Question Type : MCQ
Question ID : 6182781099

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.34 क� � यटूर नेटवक�  काड� और नेटवक�  राउटर को कने� ट करने वाल� केबल को ______ कहा जाता है।
Ans 1. रेगुलर जकै-45

2. �रकॉड�र जकै-45

3. रेफ़र�स जकै-45

4. रिज� टड� जकै-45

Question Type : MCQ
Question ID : 6182781137

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.35 MS-Excel वक� शीट म� सं� याओ ंके वे पंि�त या � तंभ ______ कहलात ेह� जो चाट� म� � लॉटेड होत ेह�।
Ans 1. डटेा ल�ज��स

2. डटेा टेबल

3. डटेा लेब� स

4. डटेा �सर�ज़

Question Type : MCQ
Question ID : 6182781128

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.36 एक वक� शीट क� एक सेल क� फ़ॉम��टगं को उसी वक� शीट क� दसूर� सेल म� लागू करने के �लए, आप
�न�न�ल�खत म� से ______ का उपयोग कर�गे।

Ans 1. Data > Recent Sources
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2. Format > Cells

3. Paste Special > Values

4. Paste Special > Format

Question Type : MCQ
Question ID : 6182781121

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.37 ‘Protect Workbook’ फ़ं�शन � या करता है?

Ans 1. यह वक� बकु को इस तरह से र��त करता है �क इस तक केवल वह� लोग पहँुच सकत ेह� िजनके पास
इसका पासवड� होगा।

2. यह वक� बकु को �ोटे� टेड फ़ो�डर म� र��त करता है।

3. यह वक� बकु को इ� सट�, �डल�ट या मवू �कए जाने से रोकता है।

4. यह वक� बकु को सरु��त सव�र पर ले जाता है।

Question Type : MCQ
Question ID : 6182781116

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.38 वॉयरलेस नेटवक�  का इ� तमेाल करत ेसमय, SSID इनम� से �कसे �न��पत करता है?

Ans 1. �डवाइस ID

2. डायल-अप ए� � ट�शन

3. �स� नल � ��थ ऑफ़ द नेटवक�

4. य�ूनक आइड��टफायर ऑफ़ अ वॉयरलेस नेटवक�

Question Type : MCQ
Question ID : 6182781140

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.39 MS-Word म� टे� � ट क� फॉम��टगं करत ेसमय �न�न�ल�खत म� से कौन सा वधै �वक� प नह� ंहै जो उपल� ध
होता है?

Ans 1. सपुरि� �� ट

2. ए� � पोन�ट

3. � �ाइक�ू

4. सि� � �� ट

Question Type : MCQ
Question ID : 6182781100

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.40 �न�न�ल�खत म� से �कसे/�क� ह� लो-लेवल ल��वेज के �प म� प�रभा�षत �कया जा सकता है?
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Ans 1. बे�सक, कोबॉल, फो�ा�न

2. �बी

3. C, C++

4. असे� बल�

Question Type : MCQ
Question ID : 6182781088

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.41 MS-Excel 2016 म� आप वक� शीट को �रनेम कैसे कर�गे?

Ans 1. Left-click on the sheet name > Rename

2. File menu > Rename

3. Right-click on the sheet name > Rename

4. Edit menu > Rename

Question Type : MCQ
Question ID : 6182781110

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.42 MS-Word म� �कसी टे� � ट का फ़ॉ�ट प�रव�त�त करने के �लए � या करना होगा?

a) प�रव�त�त �कए जाने वाले टे� � ट को सेले� ट कर�गे।
b) ‘Home’ टैब पर, ______ बॉ� स पर ‘drop-down arrow’ पर ि�लक कर�गे। उसके बाद वां�छत फ़ॉ�ट
का चयन कर�गे।

Ans 1. फ़ॉम�ट

2. साइज़

3. � टाइल

4. फ़ॉ�ट

Question Type : MCQ
Question ID : 6182781102

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.43 MS-Excel म� इनम� से �कस टूल का उपयोग एक सेल के फ़ॉम�ट को �कसी दसूर� या से� स क� र�ज़ म� कॉपी
करने के �लए �कया जाता है?

Ans 1. Split cells

2. Format painter

3. Paste as formula

4. Paste as a value

Question Type : MCQ
Question ID : 6182781119

Status : Answered
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Chosen Option : 1
Marks : 0.00

Q.44 काया�लय म� इ� तमेाल �कए जाने वाले लपैटॉप म� ______ क� डटेा � टोरेज़ �मता होती है।
Ans 1. 512 GB

2. 512 MB

3. 512 TB

4. 512 KB

Question Type : MCQ
Question ID : 6182781081

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.45 MS-PowerPoint म�, टे� � ट डाइरे� शन म� �डफ़ॉ� ट �प से �कतने �वक� प उपल� ध होत ेह�?
Ans 1. 6

2. 4

3. 10

4. 8

Question Type : MCQ
Question ID : 6182781131

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.46 MS-Word 2016 म� मेल मज� का इ� तमेाल करत ेहुए लेब� स को ��टं करने के �लए:

‘______’ > ‘Start Mail Merge’ > ‘Labels’ पर जाएँ।
Ans 1. इ� सट�

2. ��एट

3. मेल मज़�

4. म�ैल�ंज़

Question Type : MCQ
Question ID : 6182781108

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.47 ______ जड़ुी हुई हाड�वेयर �डवाइस तथा ऑपरे�टगं �स� टम के म� य आव� यक �प से �नबा�ध क� य�ुनकेशन
क� स�ुवधा देता है।

Ans 1. इं� टालेशन �ाइवर

2. �डवाइस फ़ाइल

3. �डवाइस �ाइवर

4. �डवाइस इं� टालर

Question Type : MCQ
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Question ID : 6182781094
Status : Answered

Chosen Option : 2
Marks : 0.00

Q.48 कॉलम B क� सम� त से� स के क�टे�ट को बो� ड व इटै�लक करने के �लए, आप � या कर�गे?

Ans 1. कॉलम B को सेले� ट कर�गे, तथा कमांड Paste > Bold > Italic का उपयोग कर�गे

2. कॉलम B को सेले� ट कर�गे, और होम (Home) मे� य ुके अतंग�त फ़ॉ�ट (Font) �ुप म� ‘B’ तथा ‘I’
का उपयोग कर�गे

3. कॉलम B को सेले� ट कर�गे, तथा कमांड Format Painter > Bold > Italics का उपयोग कर�गे

4. कॉलम B को सेले� ट कर�गे, तथा कमांड Ctrl + I का उपयोग कर�गे

Question Type : MCQ
Question ID : 6182781120

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.49 MS-Excel रैप टे� � ट फ़�चर, टे� � ट को समायोिजत करने के �लए, ______ को ॲडज� ट करता है।
Ans 1. शीट क� चौड़ाई (sheet width)

2. कॉलम क� चौड़ाई (column width)

3. सेल क� ऊँचाई तथा चौड़ाई (cell height and width)

4. रो क� ऊँचाई (row height)

Question Type : MCQ
Question ID : 6182781114

Status : Answered
Chosen Option : 2

Marks : 0.00

Q.50 �वडंोज़ ए� सपी (Windows XP) म� ______ बटन होत ेह� जो आपको सामा� य टूल� तथा वत�मान म� चल रहे
�ो�ाम� तक � व�रत ॲ� सेस देत ेह�।

Ans 1. � टाट� बटन

2. टा� कबार

3. नो�ट�फ़केशन ए�रया

4. कं�ोल पनैल

Question Type : MCQ
Question ID : 6182781090

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.51 र�ज A1:D5 म� �कतनी सेल होती ह�?
Ans 1. 9

2. 20

3. 4

4. 5
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Question Type : MCQ
Question ID : 6182781125

Status : Answered
Chosen Option : 2

Marks : 1.00

Q.52 MS-Word म� ��टं ��� य ूपाने के �लए, Ctrl + P के अ�त�र� त �कस शॉट�कट कंुजी का उपयोग �कया जा
सकता है?

Ans 1. Ctrl + F9

2. Ctrl + Shift + W

3. Alt + F2

4. Ctrl + F2

Question Type : MCQ
Question ID : 6182781103

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.53 I/O �डवाइस सीधे मदरबोड� से जड़ु ेइले��ॉ�नक मॉ�यलू से जड़ु ेहोत ेह� िज�ह� ______ कहा जाता है।
Ans 1. �डवाइस �ाइवर

2. �डवाइस कं�ोलर

3. I/O कं�ोल य�ूनट

4. बस

Question Type : MCQ
Question ID : 6182781085

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.54 MS-Excel म� ‘Cell Styles’ फ�चर के संदभ� म� �न�न�ल�खत म� से कौन सा कथन स� य नह�ं है?

Ans 1. जब आप एक समय पर एक सेल या से� स क� र�ज म� एक से अ�धक फ़ॉम�ट लागू करना चाहत ेह�, तो
� टाइल लागू करना सवा��धक आसान होता है

2. MS-Excel म� फ़ॉम��टगं के �लए अनेक �ब� ट-इन � टाइल होती ह� िज� ह� आप लागू या प�रव�त�त कर
सकत ेह�

3. � टाइल फ़ॉम��टगं कैरे� टरि�ट� स, जसेै फ़ॉ�ट का नाम, साइज़, कलर, एलाइनम�ट व � पे�सगं, का
एक सेट होता है

4. इससे पंि�त क� ऊँचाई या � तंभ क� चौड़ाई प�रव�त�त होती है

Question Type : MCQ
Question ID : 6182781122

Status : Answered
Chosen Option : 3

Marks : 0.00

Q.55 �न�न�ल�खत म� से कौन सा एक आउटपटु �डवाइस नह�ं है?

Ans 1. � लॉटर

2. मॉ�नटर
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3. � कैनर

4. ��टंर

Question Type : MCQ
Question ID : 6182781084

Status : Answered
Chosen Option : 1

Marks : 0.00

Q.56 �र� त � थान क� प�ूत � कर�:

Start → ______ → MS Office → MS Word.
Ans 1. Applications

2. Windows

3. Menu

4. All Programs

Question Type : MCQ
Question ID : 6182781095

Status : Answered
Chosen Option : 4

Marks : 1.00

Q.57 आपने एक MS-Excel � �ेडशीट म� पाँच �व�भ� न � तंभ� म� डटेा एंटर �कया है, ले�कन आपने देखा �क आप
तीसरे � तंभ म� उपल� ध सचूना को पढ़ नह�ं पा रहे ह�? आप सभी पाँच � तंभ� क� एक जसैी �दखावट चाहत ेह�।
आपको � या करना चा�हए?

Ans 1. तीसरे सेल क� दा� बाउं�ी पर डबल ि�लक करना चा�हए

2. तीसरे सेल क� बा� बाउं�ी पर ि�लक करना चा�हए

3. तीसरे सेल क� बा� बाउं�ी पर डबल ि�लक करना चा�हए

4. तीसरे सेल क� दा� बाउं�ी पर ि�लक करना चा�हए

Question Type : MCQ
Question ID : 6182781115

Status : Answered
Chosen Option : 1

Marks : 1.00

Q.58 एक वक� शीट से दसूर� वक� शीट म� जाने के �लए �न�न�ल�खत म� से कौन सा शॉट�कट कंुजी/कंुिजयाँ उपय�ु त है/
ह�?

Ans 1. Ctrl + Tab

2. Ctrl + Page Up

3. Ctrl + Page Down

4. Tab

Question Type : MCQ
Question ID : 6182781112

Status : Answered
Chosen Option : 2

Marks : 0.00
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MS-Excel वक� शीट म� सभी सेल �डफॉ� ट �प से ______ होती ह�, ले�कन उ� ह� ______ के �प म� फ़ॉम�ट
�कया जा सकता।

Ans 1. अनलॉ�ड, लॉ�ड

2. लॉ� ड, अनलॉ�ड

3. �ोटे� टेड, लॉ� ड

4. �ोटे� टेड, अन�ोटे� टेड

Question Type : MCQ
Question ID : 6182781123

Status : Answered
Chosen Option : 4

Marks : 0.00

Q.60 �न�न�ल�खत म� से कौन सा �ो�ाम यज़ूर को �डल�ट फाइ� स तक ॲ� सेस �दान करता है?

Ans 1. �वडंोज़ ए� � � लोरर

2. �वडंोज़ मनेैज़र

3. �ाउज़र

4. इंटरनेट ए� � � लोरर

Question Type : MCQ
Question ID : 6182781092

Status : Answered
Chosen Option : 3

Marks : 0.00
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